Valley

Library Consortium

Horizon 7.5.2 Client Installation on Windows 7

These instructions are for installing the Horizon 7.5.2 client on a Windows 7 PC.

This process was developed from our experience installing the software on a fairly small number of PCs and configurations. It is
possible that other systems may produce different messages or present other challenges that are not addressed here.

Someone following these instructions to install the Horizon client should be familiar with installing software on a Windows computer,
navigating the file system, and copying files between directories. If you have any questions, please call the VLC trouble line at
(989) 497-0925 ext. 0.
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System Requirements:
Minimum Hardware Requirements Recommended Hardware Requirements

e  Pentium I1, 864 MHz or greater e Pentium IV, 1.4 GHz or greater
e 256MB of RAM e 1 GB of RAM (WindowsXP) or
e 100 MB free disk space 2 GB RAM (Windows 7/Vista)
e 10/100 Mbps Network Interface Card e 1 GB free disk space
e Color SVGA monitor e 10/100 Mbps Network Interface Card
e 2X CD-ROM drive e Color SVGA monitor
e Mouse or track ball e 20X CD-ROM drive
e Microsoft Windows 7, XP Pro (SP2), Vista e Mouse or track ball

e  Microsoft Windows XP Pro (SP2), Vista, Windows 7 in

Windows XP compatibility mode

Firewall Information

The Horizon staff client requires outbound TCP access from your network to the following addresses and port numbers at the VLC:
e 198.111.204.18:2025
e 198.111.204.21:1099, 4444, 4445, 4446 and 9999
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Important!

The Horizon Client software will lose connection with the Horizon database if the PC goes into “System Standby” or “System
Hibernate” modes, so it is necessary to disable these features.

In Windows XP, this can be done through the Display Control Panel->Screen Saver tab—>Power button—>Power Schemes tab.

Set both “System Standby” and “System Hibernates” to “never.” These settings can be user specific, so make sure that they are
configured properly for each Windows users that logs into that PC.

For Windows 7, go to the Control Panel for Appearance and Personalization - Personalization ->Power Management button
—>Power Schemes and set “Put the compute to sleep” to “Never” for the chosen Power Plan.

Part 1: Install Sybase 15.5 Open Client

1. Log inas an Administrator and insert the Horizon 7.5.2 DVD.
2. If “autoplay” is enabled on the computer, the Horizon Information Management System installation menu will appear. If
not, open My Computer, open the DVD drive, and double-click Browser.exe.

3. Click Install Horizon 7.5.
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_Automated Client Update
#TTThird Party Prodacts

Clicking on this option will fake youto a
list of third party products used with
Horizon.

ack

4. From the “Choose a product” menu, select Third Party Products.

_ 4 orizons,
i InfomatiohiManageme
System g ,,

____JRE {Java Runtime)
__Adobe Acrobat Reader

Clicking on this option will install
the 15.5 Sybase Open Client (both
x86 andlor x64).

Back

5. Select Sybase 15.5 Open Client.
6. The “Sybase Adaptive Server Enterprise” installation will begin.
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M Adaptive Server Enterprise 15.5 PC Client CD o

Sybase”
Adaptive Server

‘Enterprise® 5 §

g =1 =

7.

U Adaptive Server Enterprise PC Client =] e |

Adaptive Server Enterprise PC Client ‘

Introduction

Installmpwhere will guide you through the installation of Adaptive Server Enterprise PG Client
Itis strongly recommended that you quit all programs before continuing with this installation.

Click the ‘Nest' button to proceed to the next screen. Ifyou swantto change something on a presious screen, click the
Previous' buttan.

“Youmay caneel this installation at any time by clicking the 'Cancel' bution.

8. When prompted, click “Next.”
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.— 3
9 Adaptive Server Enterprise BC Client =)

Adaptive Server Enterprise PC Client

End-user license agreement

End-user license agrament
Read the fallowing license agrezment carsfully, then choose ko agree or disagree with the agresment,

|Select 3 geagraphic location v

)
Spain(Spanish)
Sweden
lSwitzerland(English)
| Taiwan

lUnited Kingdom i
e |

|Any Other Locations -

(©) 1DO NOT agree ko the terms of this license and wil not install this software.

I agres to the terms of the Sybase license for the install location spedified.

Cancel Pravious

9. From the “Select a geographic location” pull-down menu, select “United States of America.”
10. Review the License Agreement.

11. Select “I agree to the terms of the Sybase license for the install location specified.”

12. Click Next to continue.

-
i Adzptive Server Enterprise PC Client e

Adaptive Server Enterprise PC Client

Choose Install Folder

Where Would You Like to Install?
Ci\Sybase

Restore Default Folder | [ Choose

Cancel Previous

13. Accept the default “Destination Directory” of C:\sybase by clicking Next.

Destination ﬂ
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14. If you receive the message “The directory does not exist,” click Yes to create it, and continue to step 15 below.

"%, Adaptive Server Enterprise PC Client o] = =

Adaptive Server Enterprise PC Client §

Warning You have chosen to install into an existing directary If you proceed with this mstallation, any older
versions of the products you choose to install that are detected in this directory will be replaced.

Cancel Previous

15. If you receive the message above that “You have chosen to install into an existing directory,” you may need to uninstall a
previous installation of Sybase before continuing. Select Cancel, then attempt to uninstall the current Sybase installation
through the “Add or Remove Programs” control panel or from “Start: All Programs: Sybase: uninstall” before beginning the
Sybase 15.5 installation process again. If you would like assistance, please contact the VLC.

@ Adaptive Server Enterprise PC Client = 3]

Adaptive Server Enterprise PC Client |

Choose Install Set

Typical

The most eommon applivation features will be installed. This option is recommended for most users,

Pk

Custom
Chaose this option to customizs the festures to be installed

Cancel Pravious

16. Select a “Typical” setup type and click Next.
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17. Sybase will check the system information then display a summary of options selected. Click Next.

Adaptive Server Enterprise PC Client §

Pre-Installation Summary

%) Adaptive Server Enterprise PC Client [E=

Please Review the Following Before Continuing:

Product Name:
Adaptive Server Enterprise PC Client

Install Folder:
C\Syhase

m

Product Features:
Open Client
ASE ODBC Driver
ASE OLE DB Driver
ADONET
SySAM License Utilities
Interactive SQL
Sybase Central
SySAM Plug-in
Agent Management Console
Adaptive Server Plug-in
QRTuNe

18. Please wait while the installation completes. This may take several minutes.

4 Adaptive Server Enterprise PC Client = e

Adaptive Server Enterprise PC Client §

Remember ASE Password

ASE Plug-in has the option to "remember passwords after connecting to servers”. The passwords are encrypted and
stared on a per-user hasis. If for security reasons you do notwant ASE Plug-in to store any passwords, you can
disable this feature

@ Enable

©) Disable

19. Make sure “Enable” is checked and then click Next.
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g Adsptive Server Enterprise 2C Client [ESREE =

Adaptive Server Enterprise PC Client §

Installation Completed

The installation was successful

Please check regularly for updates at http://wurw sybase com/downloads

20. When completed, click Done.

& Adaptive Server Enterprise 15.5 PC Client CD L = — é}

»

Sybase®

Adaptive Server
'E nterpgise@

21. Click Exit to complete the Sybase 15.5 installation.
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Part 2: Install Java Runtime Environment 1.6
22. After the Sybase installation, you should be returned to the Horizon Third Party Products menu.

* __Adobe Acrobat Reader

Clicking on this option will install
the Java 1.6 Runtime Environment.

23. Select JRE (Java Runtime).

Welcome to Java™

Java provides safe and secure access to the world of amazing Java content.
From business solutions to helpful utilities and entertainment, Java makes
your internet experience come to life.

Mo personal information is gathered as part of our install process. For more
information on what we do collect, see http://java.com/data

[ View License Agreement... ]

Click "Install" to accept the license agreement and install Java now.

l Cancel I [ Install =

24. Click View License Agreement.
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25. Review the license agreement, then click Close to return the “Java Setup — Welcome” window, then click Install.

i5 Java Setup - View License Agreement

Sun Microsystems, Inc. Binary Code License Agreement

for the JAVA SE RUNTIME ENVIRONMENT (JRE) WERSION 6 and
AN AR RUMTIME WERSION 1

SUN MICROSYSTEMS, INC. ("SUN"Y 1S WILLING TO LICENSE THE
SOFTWARE IDENTIFIED BELOWY TO YOU ONLY UPON THE CONDITION
THAT ¥OU ACCEPT ALL OF THE TERMS COMNTAINED IM THIS BINARY
CODE LICEMSE AGREEMENT AND SUPPLEMENTAL LICENSE TERMS
(COLLECTWELY "AGREEMENT"). PLEASE READ THE AGREEMENT
CAREFULLY. BY DOWWMLOADING OR INSTALLIMNG THIS SOFTWARE,
YOU ACCEPT THE TERMS OF THE AGREEMENT. INDICATE
ACCEPTANCE BY SELECTING THE "ACCEPT" BUTTON AT THE BOTTOM
OF THE AGREEMEMT. IF ¥OU ARE MOT WILLING TO BE BOUND BY ALL
THE TERMS, SELECT THE "DECLINE" BUTTON AT THE BOTTOM OF THE
AGREEMENT AMD THE DOWWMLOAD OR INSTALL PROCESS WILL NOT
CONTINUE. v

26. A status bar will show the progress of the installation.

rﬁ Java Setup - Complete @1

You have successfully installed Java.

Java updates will automatically be downloaded to provide you with the latest
features and security improvements. To change this, see
http://java.com/autoupdate

27. When completed, click Close to return to the Horizon “Choose a Product” list of third-party products, then click Back to
return to the previous Horizon installation window with the selection “Horizon Client.”
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Part 3: Install Horizon Client 7.5.2

(120N
InformatiohiManageme
ystem g

_Automated Client Update
__Third Party Products

Clicking on this option will install or
upgrade your Horizon Softwi

28. At the Horizon “Choose a product” list, select Horizon Client.

Press the PAGE DOWN key to see the est of the agresment

PRODUCT LICEMSE AGREEMENT

MOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT

USE OF THE LICENSED SOFTWARE PROVIDED WITH THIS AGREEMENT [hereinafter
sometimes refermed to as “Licensed Software”] CONSTITUTES YOUR ACCEPTANCE OF
THESE TERMS. IFYOU (HEREINAFTER SOMETIMES REFERRED TO AS THE
"CUSTOMER") DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY
REMOVE THE LICENSED SOFTWARE TOGETHER %/ITH ALL COPIES FROM YOUR
COMPUTER. CUSTOMER'S USE OF THIS LICENSED SOFTWARE IS COMDITIONED
UPON COMPLIANCE BY CUSTOMER WITH THE TERMS OF THIS AGREEMENT.

Ta register your Dynix Corporation (hersinatter referred to as *Dynix”) product, please refer to
the registralion section in this f.

DEFINITION OF TERMS. Licensed Software: Each Dynix software product including
machine-readable object code [not source code) for such product, any user documentation

Do pou accept all the terms of the preceding Licanse Agreement? [ you
select Mo, the setup will close. To install Horizon 7.5.2, pou must accept

tis agresmet.

29. Review the “PRODUCT LICENSE AGREEMENT” then click Yes to accept.

License Agreement . B
Pleass read the following license agieement carefully @ SrSIDyn |x
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_
Horizon 7.5.2 i

Choose Destination Location

Select folder where setup will install files. @ SrsIDynix

Setup will install Horizon 7.5.2 in the following folder.

Toinstall to this folder, click Next. To install to a different folder, click Browse and select anather
folder.

—Destination Folder

C:\Program Files (+B8]\SirsDynistHorizon_3

30. Click Next to accept the default installation folder of “C:\Program Files\SirsiDynix\Horizon” (or on a 64-bit system,
“C:\Program Files (x86)\SirsiDynix\Horizon)

31. In the “Select Features” window, verify that ONLY the “Staff (required)” feature is selected, then click Next.

Horizon 7.5.2

Select Features
Select the features setup willinstall

Select the features you want to install, and deselect the features you do not want to install

W Administrator 0K [l m AdHoc Reports

| ] Additional Languages 0K| |7]Borower Import
Staff (required) 38588K | |DayEnd
| Miscellaneous Ultilities:

~D

Select this component to install the administrative functions. To install only some of the
functions click on change.

Space Required on C: 48200K
Space Available on C: 49631272K
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Horizon 7.5.2

Start Copying Files

Review settings before copying files.

Setup has enough information to start copying the program files. If you want to review or change
any settings, click Back. If you are satisfied with the settings, click Next to begin copying files.

Current Settings:

Installation Information:
Horizon 7.5.2
Target Directory:
C:\Program Files (x86/\SirsiDynix\Horizon_3
Java Home Directory:
C:\Program Files (x86)% ava\jiref
JYM.DLL Location:
C:\Program Files (x86)\ avajreB\bin\client

Program Shortcut Location:
C:\ProgramD ata‘\Microsoft\Wwindows\Start Menu\Programsh
C:AUsers\PublickDesktoph

32. Review the “Current Settings” then Click Next to begin copying files. A status bar shows progress for each component of the

installation.
33. When the “InstallShield Wizard Complete” window appears, click Finish. (Do NOT select “Start Horizon™)

_Automated Client Update
. Third Party Products

Clicking on this option will install or
upgrade your Horizon chent Softw:

34. At the Horizon installation screen, click Back then Exit to exit the installation program.

12/11/2013

Page 13 of 19



Valley Library Consortium

Horizon 7.5.2 Client Installation on Windows 7

Part 4. Configure the Horizon Database

35. From the Start menu, select Programs, Sybase program group, Connectivity, and the Open Client Directory Services
Editor.

36. DS editor displays the “Select Directory Services” dialog box.

37. “InterfacesDriver” should be highlighted. Click OK.

38. The “InterfacesDriver” dialog box will appear.

39. Select Add from the Server Object menu.

40. In the “Input Server Name” dialog, enter Server Name “Horizon” and click OK.

4% dsedit - DSEDIT1 - InterfacesDriver = | G

File Edit ServerObject Window Help

= | 2|

DSEDITI - InterfacesDriver foa ==
Server Attributes Values

Server Entry Version |1
Server Name Horizon
Server Service Adaptive Server
Server Status 4 Unknown

Server Address

Path

Horizon

For Help, press FL HUM

41. At the “Interfaces Driver” diaglog box, make sure “Horizon” is highlighted in the “Server” list and double-click “Server
Address” under “Attributes:”

42. From the “Network Address Attribute” box, click Add.

Input Metwork Address For Protocol @
Protocal: Mebwork Address:
TCP | |horizor vic. b mi.us 2025

Cancel

43. In the “Input Network Address For Protocol” box, select Protocol “TCP” and enter Network Address
“horizon.vlc.lib.mi.us,2025” (please note, that’s a comma before the 2025, the other punctuation marks are periods.)

44. Click OK to return to the “Network Address Attribute” dialog.

45. You will see the address you just entered listed under “ProtocolNetwork Address.”
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46. Click OK to return to the “InterfacesDriver” dialog box. Confirm that the “Server Address” is now listed as “TCP -

horizon.vlc.lib.mi.us,2025”
47. To test the connection, highlight “Horizon” in the “Server” list then select “Ping Server” from the “Server Object” menu.

Server Object Mame:

Harizon

FrotacolServer Address

horizon, vl lib. mi.us, 202!

Select a gerver address Lo ping.

48. Click the Ping button. You should see the message “Open connection to server at (horizon.vlc.lib.mi.us,2025) succeeds.
Close connection Succeeds.”

dsedit S5

Ping to herizen.vlclib.mius, 2025 using protocol TCP
Connect succeeded.

49. If the connection succeeds, click OK on the message, then Done on the “Ping” window. If the connection fails, make sure the
information entered in step 46 is correct. If the information is correct and the connection still fails, contact the VLC.

Attribute s Values

Server Entry Yersion |1
Server Name Horizon

Server Service Adaptive Server Enterprise
Server Status 4 Unknown
Server Address TCP - horizon.vlc.lib.mi.us.2025

Path

Horizon

[ 4

For Help, press FL
| p. p

50. Select “Exit” from the “File” menu to close dsedit.
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Part 5: Launch Horizon and Log In
Note for Computers with Multiple Windows Usernames

* The Server Database and Password information is stored on your computer for each Windows username. In order to properly store
the Horizon database credentials, steps 51-58 must be performed for each Windows username that will be using the Horizon client.

51. Launch the Horizon 7.5.2 client from the Start menu or desktop icon.

Horizbn 7.5.2

Information Management System

Copyright SirsiDynix 2007-2012. All rights reserved.

User: Iuse' Server: Horizon ¥ l
Password: I Database: |horizon v I

oK | Options | Seryver... |

Cancel I

52. From the Server pull-down menu, select “Horizon,” then click Server.

Server Login Information

3

Server: |Hor'izc|n j
Login; ||
Password: |

Ok Cancel

53. In the “Server Login Information,” enter the Login and Password provided to you by the VLC.
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Copyright SirsiDymix 2007-2012. All rights resened,

User: Ius,a— Server: IHDtiznn j
Bassword: I LDatabase: Ih-nriznn j

)4 | Options... | Server... | Cancel |

54. When you return to the Horizon 7.5.2 screen, select horizon from the “Database” pull-down list.

55. Enter a Horizon User name and Password.
56. Click OK

57. The Horizon 7.5.2 staff screen should appear.

Fie Edt View

elp
|[EgFmee s EEama et Y|
ik

-5 - -
peoeoeoe

[Trainee [ lovR oM [

58. Select “Exit” from the “File” menu.
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Part 6: Set Circulation Workstation ID

59. Launch the Horizon 7.5.2 client from the Start menu or desktop icon.
60. In the “launcher” column on the left side of the window, open the folder Circulation and double-click Open CKO Window.
61. Inthe “File” menu, select “Change Workstation ID.”

B x|

Enter this workstation's payment log settings:

Workstation |D I
Cash Drawer 1D I
Library Department |D I

e

62. The library director or system administrator should be responsible for assigning a Workstation 1D, Cash Drawer 1D, and
Library Department ID if cash transaction statics are kept for the library. If not, enter a value of “1”” in each of these fields.

63. Click OK

64. To exit the Horizon Client, click the X in the upper right corner or select “Exit” from the “File” menu.
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Part 7: Install the Horizon Help Center documentation (optional)

The Horizon Help Center is the online documentation accessed by selecting “Launch Help Center” from the “Help” menu. The
“Horizon Basics Guide” and the “Launcher Configuration Guide” are installed during the Horizon Client Installation performed in Part
3 of these instructions. Continue with the following instructions if you would like to install additional Help Center guides.

65. Logged in as an Administrator, insert the Horizon 7.5.2 CD.
66. Launch the Horizon installation program as you did before and select Install Horizon 7.5.

67. Select Help Center.

68. At the “Welcome to the InstallShield Wizard” window, click Next to continue.

69. Review the License Agreement, then click Yes to agree to continue.

70. Confirm that the Destination Folder is the same directory in which Horizon was installed. The default is “C:\Program
Files\SirsiDynix\Horizon.” Click Next.

Horizon Help Center Setup

Select Documents

Choose the type of library staff that will use this ion, then choose the
documents you want to install

[ ] Acq Staff oK Circ User's Guide
C: 3528K CSA Guide
2932K Media Scheduling

Reserve Staff
|7 Serials Staff
|1 Sys Admin

Description
Circulation Guides

Space Required on C: 13300K
Space Available on C: 29302404 K

71. Select the documents that you would like to install on this PC then click Next.
72. Confirm the list of documents in “Current Settings” then click Next to install.
73. When the files have completed copying, click Finish, then Back, then Exit to finish..
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